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Overview 
 
This manual is designed to provide you with an overall understanding of the journal entry 
process and associated guidelines and rules.  In addition, you will learn how to use the Web ADI 
tool to create and upload manual journal entries. 
 
This manual includes the following topics: 
 

Understanding the Journal Entry Process …………………………………….. 2 
Web ADI Tool, Journal Preparation and Upload  

One-Time Set Up Procedures ……………………………………… ...…3 
Download Web ADI template ……………………………………… …11 
Enable Macros …………………………………………………… ……...12 
Preparing a Journal Entry ………………………………………… .......15 
Uploading a Journal Entry …………………………………………. .....18 

System Validation of Web ADI entries 
Cautions, Warnings and System Error Messages ……………… .......22 

Controller’s Office Validation 
Requirements …………………………………………………… ……....26 
Recommended Best Practices ……………………………………… .....27 

Reference Information 
Selecting Accounting Dates …………………………………… ………28 
List of Values ……………………………………………… ...………….29 
Methods for reallocating dollars (accounting quick review) …...... ...30 
Cross-Segment Validation …………………………………………... …32 
Security Rules on Natural Class …………………………………… ….33 
Transfer Natural Classes ……………………………………………. …34 
Natural Class Internal Revenue and Expense Values …………….. ...35 
Budget Only Natural Class Values …………………………………. ...37 

 
User Support: 

 
I need to edit or delete an entry I uploaded— 
How do I formulate an entry for a particular accounting purpose— 
 

Alumni Relations, Dean of the College, Tuck School – Susan 
Mockus 
Dartmouth Medical School (DMS), EVP – Susan Wells 
Dean of Faculty, President’s Office, Provost, Public Affairs, 
Thayer School  – Janet Gilson 
Development – Gwendolen Gensler 

 
I don’t understand a system error message— 
I am getting a technical error message (e.g., server not available)— 
 

Contact Gwendolen Gensler  
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Understanding the Journal Entry Process 
 
Dartmouth College’s GL represents the accounting book of record for the Institution. Accounts 
summarize transactions that take place over a defined period (daily, weekly, monthly, quarterly, 
annually) related to specific chart strings.  Many journal entries are automated (AP, AR, FAMIS, 
Computer Store, etc.) and enter the GL through scheduled periodic processing.  However, 
departments sometimes need to make manual adjusting journal entries outside of the automated 
processing. 
 
Manual journal entries are primarily used to record or correct interdepartmental transactions, 
correct certain posted transactions, and record funding transfers. 
 
The GL receives journal entries from several sources as illustrated in the diagram shown below: 
 

 
 
Dartmouth College has two tools used for uploading manual entries: Web ADI which uploads 
GL chart strings only, and SPUD which uploads entries including grant strings (PTAEOs) or 
combinations of GL strings and PTAEOs. 
 
Importance of Individual Journal Entries 
 
The diagram shown below emphasizes the journal entry as the starting point for the accuracy of 
Dartmouth College’s GL, and ultimately for its financial statements. It illustrates the path of an 
automated journal entry via an application such as A/P – one invoice is part of a batch this is 
uploaded to GL that is eventually represented in the Dartmouth College Financial Statements.  
Because of the ‘summarized’ relationship between the Journal Entry and the College’s financial 
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statements, a mistake at the point of the original entry must be corrected somewhere along the 
path or the financial statements will be inaccurate. 
 

 
Types of Manual Journal Entries 
 
Manual journal entries are made for a number of reasons – correcting errors, reallocating costs, 

making adjustments, etc.  Examples of journal entry adjustments include: 
 

• Redistribution of charges to a different funding or activity segment in a chart string 
• Corrections to existing posted charges. 
• Redistribution of central charges (e.g., copier) 
• Transfers between funding sources or between departments 
• Internal rebillings for services, fees, interdepartmental charges 
• Service Center Billings (For non grant service center charges only.  Grant-related transactions are 

processed using SPUD) 
 
Flow of Manual Journal Entries 

 

 
 
At Dartmouth, manual journal entries originate at the departmental level, as the initial upload 
process is decentralized.  Departmental preparers will submit Manual journal entries at their 
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desktops using the WebADI tool within Excel.  This template communicates with the Oracle 
General Ledger (GL) at upload and performs certain validations (See section System Validation 
of WebADI Entries).  Preparers will edit entries as needed until they achieve a successful upload. 
 
Once a Manual entry is uploaded into the GL, it remains in a queue until it is reviewed by the 
Controller’s Office.  General procedure is that every midday, reviewers receive a list of the 
entries uploaded during the previous 24-hour period.  Entries are reviewed and posted, rejected, 

or edited as needed based on Controller’s Office requirement (see section Controller’s Office 
Validation).  Manual entries will be available in IRA reports the day after they are posted to the 
GL. 
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Web ADI Tool, Journal Preparation and Upload 
 
The following is the set of tasks to be done to prepare and upload manual journal entries: 
 

 
 
One-Time Set Up Procedures 
 
The Web ADI template is an Excel spreadsheet but because of Macros written to allow 
communication with the Oracle General Ledger, there are security settings to be adjusted in 
Excel and Internet Explorer. 
 

Excel 2003 and similar 

1. Navigate to Tools → Macro → Security:
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2. Select the Security Level tab, and choose Medium.
 

3. Select the Trusted Publishers/Sources tab, and make sure “Trust access to Visual 

Basic Project” is checked. 

  

4. Click OK.  These settings will remain in place. 
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Excel 2007 
 
Click the Microsoft Office Button in the upper left hand corner, and then click Excel Options.  
 

 
 
Click Trust Center.  

 
 
 
 
 
 
 



Dartmouth College  Manual Journal Entries with Web ADI 
 

8 
Effective 11/10/09 

 
Click Trust Center Settings. 
 

 
 
Click Macro Settings. 
 

 
 
Click the options that you want: 

Check- Disable all macros *with* notification:  This will allow you to choose to Enable 
Macros for ADI templates. 
Check- Trust access to the VBA project object model. Turn on access by selecting the 
check box.  
 

 
 

Click OK to save the settings.  
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Internet Explorer 7 or 8, even if this is not your primary browser: 
 
Choose Tools->Internet Options 

 
 
Click Custom Level 
 

 
 
Scroll down to Scripting and Enable all items in the list. Your list may not match this one exactly; 
enable all items in the Scripting section. 
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Click OK.  



Dartmouth College  Manual Journal Entries with Web ADI 
 

11 
Effective 11/10/09 

Web ADI Tool, Journal Preparation and Upload 
 

Download WebADI Template 
 

Navigate to http://www.dartmouth.edu/~control/systemaccess-tools/restrictedaccess/index.html 
 

 

 
 
Click Web ADI Template link and a File Download box will appear: 
 

 
 
Save the file to your desktop. 
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The file will automatically save as an Excel worksheet (.xls).  This is valid for use with Excel 2003.  
For Excel 2007 users, after the file is opened, it should be re-saved as an “Excel Macro-Enabled 
Workbook”, extension (.xlsm) . 
 

 
 
Once the blank template is saved to the desktop, it can be re-used as needed and does not need 
to be downloaded from the website again. 
 
 
Enable Macros 
 
To begin preparation of a Manual journal entry, open the saved template in Excel.  Enable 
Macros, as this creates the ability to communicate with the Oracle GL. 
 
In Excel 2003, click Enable Macros in Security Warning when template is opened: 
 

 
 
In Excel 2007, a Security Warning bar will appear when the file is opened.  Click Options: 
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Then “enable this content” and click OK. 
 

 
 
Enabling Macros in Excel will cause the Oracle toolbar to be created: 
 
Excel 2003: 
 

 
Excel 2007: 
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Oracle Menu Option Description 

List of Values (LOV) Any place on the template that indicates “*List” will have a pull 
down list of values (LOV) for the particular cell you are in 

Upload Used to send the journal entry to the General Ledger 

Monitor Lists recent journal entries you have uploaded to GL (will provide 
confirmation numbers if you have forgotten to write them down) 

About Information about Oracle 

 
 
The functionality is now in place to prepare and upload your entry. 
 
 
Note: If during preparation or attempted upload, you see a message about protected content, 
unprotect the sheet in Excel: 
 
Excel 2003: 

 
 
 
Excel 2007:  Review � Unprotect Sheet: 
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Web ADI Tool, Journal Preparation and Upload 
 
 

Preparing a Journal Entry 
 
The journal template consists of three major areas: 
 
Context Area: pre-populated with information associated with the journal entry for your 
downloaded template.  
 

 
 
Trying to change values in these areas of the template will result in the error message shown 
below.  
 

 
 
Header Area:  This section should include general information about the journal as a whole.  
Preparer will complete this section using the following guidelines: 
 

 
 

Field Description/Format 

Accounting Date Date in the period for which the entry should be recorded. The default 
value is the current date; however, future or open dates which are 
consistent with the Oracle calendar are allowed. 

During the first three business days of each month you may post to 
either the current month or the previous month.  For example, if you 
want the journal you are uploading on August 2nd to post in July, it must 
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have a July date. 

Batch Name Batch Name or Journal Name (or both) MUST include the preparer’s 
first initial and last name.  Follow this with a summary phrase about the 
journal entry.  The first initial and full last name identifies the person 
uploading the journal entry in case that person needs to be contacted 
about their entry.  The unique description provides a unique identifier 
for each journal on reports. 
Examples S Jones SC Billing 8-23 

J Thompson PCard corrections 
E Woods Transfer to DOC 

Controller’s Office requires that this field be populated. 

Journal Name Free Form; can be same as Batch Name.  Controller’s Office requires that 
this field be populated. 

Journal Description Free Form; a phrase describing the whole journal; can be the same as 
Batch Name.  Controller’s Office requires that this field be populated. 

Reverse Journal Used if you want the journal reversed in a future period. Select ‘Yes’ or 
from the pull-down menu to reverse a future period. Otherwise, leave 
this field blank.  

Reversal Period If you selected ‘Yes’ in the Reverse Journal field, then, use the pull-down 
List of Values to select the period in which you want it to reverse.  
Otherwise, leave this field blank. 

 
 
 
Lines Area: where you enter information for specific chart strings and corresponding debits and 
credits, line description, and reference information. 
 

 
 

Upl A flag may display; disregard or doubleclick to remove if it is the only 
item in the row 

ENTITY Enter Entity segment value, no punctuation 
ORG Enter Org segment value, no punctuation 
FUNDING Enter Funding segment value, no punctuation 
ACTIVITY Enter Activity segment value, no punctuation 
SUBACTIVITY Enter Subactivity segment value, no punctuation 
NATURAL_CLASS Enter Natural Class segment value, no punctuation 

Debit Enter a positive dollar amount either Debit or Credit for each line; do 
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not enter zero or a negative number. The entry can be any 
combination of debits and credits; they do not need to be one-to-one. 

Credit Enter a positive dollar amount either Debit or Credit for each line; do 
not enter zero or a negative number. The entry can be any 
combination of debits and credits; they do not need to be one-to-one. 

Line Description Specific information about the line (e.g., vendor, invoice number, 
date).  Controller’s Office requires that this field be populated. 

Additional Line Info 1 Not required*, but provides room for additional info about the line.  
This information is not readily viewable by the reviewer and the 
system does not add information here if left blank; therefore, this 
information is not required.  This information, however, can be 
viewed on reports, so it may be beneficial for the reader of a report to 
have this additional information. 
 
*For transfer journal entries, Additional Line Info 1 must contain the offset 
string (other side of the transfer) 

Messages Feedback messages from Oracle system. For example: ☺ indicates that 
the line has been accepted; � indicates that there is an error in the line, 
and will be followed with an explanation of the error. 

Totals Totals for Debit and Credit columns are automatically computed on 
this line. 

 
The Web ADI Journal Entry Tool utilizes all of the standard Excel formatting and template 
features, such as the copying and pasting cells feature which is particularly useful when you are 
entering multiple lines for a given chart string. 
 
Note:  Oracle will upload only what it entered in the white spaces in the template.  You may 
write notes in areas above and below the template information, or add sheets to a workbook for 
supporting information.  These actions will not affect the upload of journal information. 
 
You may also leave blank lines between sections in the Lines area if it helps with your readability 
of your journal.  Oracle will disregard blank lines. 
 

Save the file in an Excel format. 

Select SAVE AS from the File Menu (Excel 2003 as .xls and Excel 
2007 as .xlsm  (Macro-Enabled Excel Workbook)) and create a 
filename for this sheet according to your department standards.  

Upload the journal. 
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Web ADI Tool, Journal Preparation and Upload 
 

Uploading a Journal Entry 

 
Once a journal entry has been completed, it is uploaded to the General Ledger from within Excel. 
 
Navigate to the Oracle tool bar in Excel (in Excel 2007 it is under Add-Ins) and choose Upload: 
 
Excel 2003: 

 
 
Excel 2007: 

 
 
 
Enter your Oracle username and password: 
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Choose DC GL Journal responsibility and click Select.  (You may have DC GL Journal Transfers 
or another variation on DC GL Journal instead.) 
 

 
 
 
A Journals Upload dialog box will appear; click either Upload button to upload your entry. 

 
The Journals Upload window will display “Processing: Upload” and check off processing tasks 
as it completes them. 

 
 
A successful upload will return a Confirmation screen containing a Journal Import Request ID.  
Record this number before closing the window; it is a unique identifier for your entry.  You will 
also see smiley faces in the Messages area on ALL lines of the journal. 
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An unsuccessful upload will result in an error message in the Journals Upload box OR in the 
Messages area of the template: 
 

 
OR 

 
 
 
 
You must have all green faces and a confirmation number for the entry to have successfully 
uploaded.  If there are any red faces, and/or an error message in the dialog box, NONE of the 

lines were uploaded.  Edit the template as needed (See section System Validation of 
WebADI Entries for explanation of error messages) and re-upload. 
 
Note the number of rows being uploaded and verify that number with the “xxx rows 
successfully uploaded” message you receive.  This is extremely important for large entries where 
every row of the journal is not viewable on one screen and therefore the green smiley faces 
cannot be readily seen for all rows.  This will ensure that ALL rows were uploaded successfully.  
We have discovered a few instances where rows inserted at the end of an entry were not 
included in the upload probably due to a formatting change. 
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If you have uploaded an entry and know you need it deleted or edited, please contact the 
Controller’s Office analyst who reviews entries for your division.  If you have uploaded the 
same entry more than once, you don’t need to upload a reversal; your reviewer can delete the 
additional entry or reverse a posted duplicate. 
 
   Alumni Relations – Susan Mockus 
   Dartmouth Medical School (DMS) – Susan Wells 
   Dean of Faculty – Janet Gilson 
   Dean of the College – Susan Mockus 
   Development – Gwendolen Gensler 
   EVP – Susan Wells 
  President’s Office – Janet Gilson 

Provost –  Janet Gilson 
  Public Affairs – Janet Gilson 
  Thayer School – Janet Gilson 
  Tuck School – Susan Mockus 
 
A successful upload places your entry in a queue for review and posting by the Controller’s 

Office.   Please see Controller’s Office Validation section below for review criteria. 
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System Validation of WebADI Entries 
 
Generally speaking, journal preparers are permitted to upload journals across department 
strings regardless of their own location and account responsibilities.  However, there are system-
wide rules that make basic checks on segment combinations within strings, and segment values 
used. 
 

Cautions, Warnings, and Error Messages 
 
In some instances, Web ADI will “overlook” errors that you have made.  The entry will go 
through and you will not receive a warning or error message. Therefore, it is important that you 
review your work prior to uploading.  Some examples include: 

• Uploading the same entry twice. 
• Uploading an entry that debits and credits the same chart string for the same amount. 
• Uploading with blank fields: Batch Name, Journal Name, Journal Description or Line 

Description. 
 
Upload Window Error Messages (displayed in Journals Upload dialog box): 
 
Invalid Accounting Date 
 
A valid Accounting date must be specified in the Header.  It must be in an ‘open’ or ‘future-
enterable’ period; use the LOV lookup to verify. 
 
 
 
 
 
 
 
 
 
 
 
Invalid Reversal Date 
 
When “Reverse Journal” is set to Yes, then a valid Reversal Period must be specified.  If the 
reversal period is invalid, use LOV lookup to verify and select the correct reversal period. 
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Template Lines Error Messages (displayed in Messages area in the template): 
 
Unbalanced Entry 
 
Total debits do not equal total credits. Review and correct as needed. 
 

 
 
Cross-Segment Validation Rule 
 
A chart string combination has been entered which violates a defined cross-segment validation 
rule.  Verify and correct the chart string segments as needed.  
 

 
 
Non-Existent Segment Value 
 
A segment value has been entered which does not exist in the Chart of Accounts.  In the 
following example, a Natural Class of 2000 and a Natural Class of 2001 do not exist.  Verify and 
correct the segment values. 
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Unallowable Natural Class 
 
Certain natural class values have been secured against entry.  Verify and enter the correct natural 
class value to be used. 

 
 

 
 
Error Messages: Debit and Credit on Same Line 
 
Each line must have a debit or a credit, but not both.  Move either the debit or credit to another 
line. 
 

 
 
Reversal Period Left Blank 
 
When “Reverse Journal” is set to Yes, a valid Reversal Period must be specified.  If the reversal 
period is left blank, you will receive the error message shown below.  Update the template by 
entering a reversal period. 
 

 
 
Too Many Decimal Places 
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Lines Added at Total Area 
 
Lines may be added to a template, but be sure to add them in the white Lines area.  Lines added 
at the Totals line will not be uploaded: 

 
 

 
 
 
 
“Orphan” Upload Flag 
 
The system will expect further information on a line with a flag.  Double-click on or clear the cell 
to remove this flag.  For lines to be uploaded, the flag is not required and they will upload 
whether or not there is a flag in the Upl column. 
 

 
 
 
 
 



Dartmouth College  Manual Journal Entries with Web ADI 
 

27 
Effective 11/10/09 

Controller’s Office Validation 
 

After a Manual entry is successfully uploaded, it sits in a queue to be 
reviewed by the Controller’s Office.  The following section outlines 
what the reviewer looks for when evaluating journal entries for 
posting.  If needed, the preparer will be contacted for clarification of 
the entry, or the entry will be rejected from the system. 

 

Requirements: 
 
A Debit or Credit cannot be zero or a negative number. 
 
JE Batch Name must include the uploader’s first initial and last name.  JE Batch Name, JE Journal 
Name and JE Journal Description may not be left blank. 
 
Line Description in the Lines area of the template may not be left blank. 
 
Internal Natural Class debits and credits must net to zero. 
 
Transfer Natural Classes must match correctly and offset chart strings for transfer entries must 
be included in “Additional Line Info 1”. 
 
Transfers out of RFM (Restricted Funds Management) category level 4 are not allowed. 
 
The Reviewer will look at the transactions in the account string being credited when moving an 
expense or the account string being debited when moving revenue to see that the 
charge/revenue was indeed posted to that account string.  When nothing is found to be moved 
or the entry is for more than the account’s year to date balance, the entry will either be rejected or 
you will be contacted for more information. 
 

Certain Sources cannot be journaled: 
 

When analyzing transactions to be moved, check the JE Source listed in transaction report detail 
to make sure it is a Source you are allowed to journal using WebADI. 
 

Journal entries can be used to correct transactions from CBORD, COSTTRANSFER_DC, 
Hanover Inn, PCard, TRAVEL_DC, and Resource25.  Journal entries can also be used to 
correct transactions from a service/recharge center (Sources beginning with 
“SRVCTR…”) but the natural class must remain in the Service Center range (7811-7826).  
Service Center transactions can also be corrected by the Service Center.  Journal entries 
to correct a transaction should not be done until the original transaction has posted. 
 

Journal entries cannot be used to correct transactions posted to the GL by the following 
satellite or Oracle subsystems (referred to as sources in the GL): Accounts Receivable 
Accounts Payable, Advance, Banner, Benesoft, Cashiering, Computer Store, The Daily 
Dartmouth, FAMIS, Inventory, OGA (“Projects”), Oracle Labor Distribution (“OLD”), 
Payroll, Telephone Services (Pinnacle), Utilities Billing System, and Yardi.  Please contact 
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a representative for the satellite or Oracle subsystems regarding what information they 
need to make the correction.  Contact information by Source is listed at 
http://www.dartmouth.edu/~control/reference/ . 
  

Entries to Balance Sheet Natural Classes: 

 
The balance sheet funding value - 909000 – must be used in combination with the 
following types of balance sheet natural classes (assets and liabilities):  cash, cash on 
hand, petty cash, clearing accounts, revenue receivables, allowance for doubtful 
accounts, prepaid expense, inventory, deferred charges, investments (purchase of and 
realized gains/losses), Auxiliary capitalized fixed assets, Auxiliary accumulated 
depreciation, deferred revenue, accounts payable, and other short-term liabilities. 
 
The following types of balance sheet natural classes (assets and liabilities) are not used 
in combination with the balance sheet funding value 909000: notes and loans receivable, 
internal loans receivable/payable, non-Auxiliary capitalized fixed assets, non-Auxiliary 
accumulated depreciation, gifts in kind, real estate for sale, long-term liabilities, and 
bonds/notes payable.  For these balance sheet natural classes, use the same funding 
value as the offset account string. 
 
The balance sheet activity value - 910000 - is used with the following balance sheet 
natural classes (assets and liabilities) when the Institutional entity 001 is used: cash, 
accounts payable, cash advances, fringe pool. 
 

Preferred Best Practices: 
 

PCard corrections: The reviewer must locate Pcard and other charges being corrected so 
it is very helpful to include the vendor’s name or description of the transaction and date 
(month/day) in the line description field so the reviewer can easily find the transactions 
being corrected.  If transactions are combined, please list the individual charges in the 
line description field after the date (example: 15.20 / 25.30 / 5.15).  If correcting part of a 
transaction, please indicate total amount in the line description field (example: total chg 
$125.53). 
 
 
 
 
 
  



Dartmouth College  Manual Journal Entries with Web ADI 
 

29 
Effective 11/10/09 

Reference Information  
 
Selecting Accounting Dates 
 
Both the “Month” and “Year” fields in the Header section of the template have LOV (list of 
values) pull-down menus that you can use to select the correct accounting date (date in the 
period for which the entry should be recorded).  When you choose a date from the calendar, you 
press Select and the date is entered into the appropriate fields. Dates can also be entered 
manually.  
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Reference Information  
 
List of Values (LOV) 
 
There is a separate column in the Excel sheet for each segment of a chart string.  By double-
clicking in any chart string segment column, you will get an “Enter Flexfield” pop-up screen that 
provides a search capability to locate the correct value for each of the chart string segments.  (See 
example below.) 
 

 
To validate a value: 

• Double-click in the segment cell. 
• Review the description displayed. Is it correct?   

- If yes, then move to the next segment. 
- If no, then change the value for the segment. 
When you have selected all of the chart string segment values, the line is populated with 
the whole six-segment chart string. 

Click Select and the system displays this message: “This combination is valid.” 
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Reference Information  
 

Methods for reallocating dollars 
 
Double-Entry Bookkeeping: “Double-Entry” refers to a method of bookkeeping in which a transaction is 
entered both as a debit to one chart string and a credit to another chart string, so that the totals of debits 
and credits are equal.   
 
Since each credit has one or more corresponding debits (and vice versa), the system of double-
entry bookkeeping always leads to a set of balanced ledger credit and debit accounts.  
Summarized amounts from these ledger balances are then used to prepare financial statements. 
 
 
The function of many manual entries is to reallocate funds because of incorrect charges, 
reallocate specific charges between departments or Activities, or reallocate committed lump-sum 
funds between departments.  The following section outlines methods for these kinds of entries. 
 
Example 1: Correcting an existing charge.  For example, a Procurement Card (PCard) charge 
gets swept to an incorrect chart string.  Or, a department decides to change how it uses its 
strings, and wants to move a number of existing charges to a new string. 
 

Debit:  New chart string, Credit: Original chart string using the original natural class 
(here, 7511 Office Supplies).  Use positive number on both sides of the entry. 

 

 
 
 
Example 2:  “Charging” another department for a good or service you provide.  For example, 
your departments produces a journal and another department buys 100 copies.  Since you are 
not moving an existing expense to the other department, you would instead bill them for the 
goods you have provided.  Because you are a Dartmouth department charging another 
Dartmouth department, you would use INTERNAL natural classes on both sides.  Debit the 
other department’s string for 7874-INT DEPT Books and Publications and Credit your 
department for 4874-INT DEPT Books and Publications  Use positive numbers in the debit and 
credit columns.  Please see below for the list of Internal Revenue and Expense natural classes. 
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Other examples include distributing the cost of a central copier (Credit the central account 4853-
INT DEPT Copying and Printing, Debit the strings using the copier 7853-INT DEPT Copying and 
Printing), or “selling” office supplies to another department (credit your string 4863 Internal 
Sales, debit their string 7863 Internal Sales).  Either department may submit the entry for this 
kind of billing. 
 

 
 

Please note that for Examples 1 and 2,it is assumed that you are moving 
an expense. Debit and credit instructions should be reversed if you are 

moving revenue or a credit against expense. 
 
 
Example 4:  Transfer.  You have committed a lump sum to an event being coordinated by 
another department.  You have committed $500 regardless of the exact expenses incurred and 
you are not receiving goods or services for the amount you’re paying.  This is a true transfer.  
Another example would be moving subvention funds into a reserve at the end of the year. 
 
Refer to the transfer matrix (Reference Information: Transfer Natural Classes) for the 
appropriate Natural Classes to use on each side of the transfer entry.  In our example, the funds 
are being moved between 368000 and 368000, so 4921 is used on both sides.  Credit the string 
receiving the funds and debit the string providing the funds, using positive numbers on both 
sides. 
 
The offset string (from the “opposite” side of the transfer) must be entered in the Additional Line 
Info 1 cells (see picture).  This is a requirement only for entries that use transfer natural classes. 
 

 
 
Transfers out of RFM (Restricted Funds Management) category level 4 are not allowed. 
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Reference Information  
 

Cross-Segment Validation 
 
When you create a manual journal entry, the chart string segment values are compared to a set of 
cross-segment validation rules.  If you enter an invalid combination of segment values, you will 
receive an error message. These rules will help prevent some inappropriate journal entries from 
being posted to the GL, and reduce the number of correcting entries. 
 
The purpose of cross-segment validation rules is to: 
 

• Specify that certain combinations of segment values in the Chart of Accounts are invalid.   
• Prevent invalid combinations of segment values when a journal entry is uploaded or a 

transaction is recorded.  
 
Cross-segment validation rules are defined system-wide, apply to everyone, and are built into 
the system.   
 
Current cross-segment validation rules that Dartmouth College has created in the GL include: 
 

• Certain Org values can only be paired with their specific Entity value (e.g., Genetics 105 has 
to be used with DMS 30). 

• The ‘General Support’ Activity range (95xxxx) can only be used with revenue Natural Class 
values (4xxx-5xxx). 

• Payroll Natural Class values (6xxx) cannot be used with Agency Entity values (90-92). 
• Balance Sheet Activity values can only use certain Balance Sheet Natural Class values. 
• Internal Expense and Revenue Natural Classes can only be used with Entity values <43. 
• Construction in Progress (CIP) ORGs, Activities and Natural Classes must correspond. 
• Entity and Funding must correspond for Subvention and Agency/Auxiliaries Fundings (e.g., 

368001 DMS Subvention only with 30 DMS). 
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Reference Information  
 

Security Rules on Natural Class 
 
To minimize the possibility of posting to an incorrect natural class value, certain natural class 
values are not available for general use.  For example, while you can post to the operating chart 
strings of your department, you cannot use certain natural classes that have been reserved for 
specific institutional needs. 
 
Some examples of these institutional natural class values to which cannot post include those 
reserved for:  

• Capital Projects 
• Endowment Principal 
• Institutional Investments 
• Student Billings 
• Loans 
• Compensation (Salaries and Fringe)* 
 

*If you feel you need to make an adjustment to a charge that has been posted to one of these 
natural classes, you must contact Employee Information Services (EIS) and have the change 
made through the payroll process. 
 
 

  



Dartmouth College  Manual Journal Entries with Web ADI 
 

35 
Effective 11/10/09 

Reference Information  
 

Transfer Natural Classes 
 
There are specific natural class values that must be used when transferring balances between 
different types of funding values.  These values are defined based on the funding values and/or 
activity values of the affected strings.  (Note:  Not all users will have access to Transfer natural 
classes; this is at the discretion of the divisional fiscal officer.) 
 
Transfer NC Matrix: 
 

 
 
 

Please contact your Controller’s Office Analyst if you are transferring between fundings not 
included in this matrix.  These would be special cases that require approval. 
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Reference Information  
 

Internal Revenue and Expense Natural Classes 
 
There are specific natural class values that have been created for ‘internal’ revenues and 
expenses.  These ‘Internal’ values must be used when one department charges another 
department for providing goods or services. 
 
Internal charges may not be moved to an ‘external’ natural class value.  For example, if you 
receive a charge from a service center (internal), you must not move the charge to an external 
natural class.  If you need to see internal and external charges of the same type grouped together, 
you will be able to do that through natural class parameters in reports. 
 
Natural class values for internal revenues and expenses have a one-to-one relationship, i.e., for 
every internal revenue natural class value, there is a corresponding internal expense natural class 
value.  For example, service center billings must use an internal revenue natural class to 
recognize their revenue; they must also use an internal expense natural class to record the charge 
to the department (or grant).  This ‘offsetting’ is necessary so that internal revenue and internal 
expenses always net to $0 on the institution’s financial statements.   
 
Internal Natural Classes must net to zero.  In addition, charges must be within the same 
“bucket” (INT DEPT, SVC CTR, FO&M).  (CIP expense natural classes may be used with more 
than one revenue bucket.)    If a transaction originated in a Source the department is allowed to 
move, and is being reallocated to a different string, the natural class must stay the same or be in 
the same bucket.  In most cases, the FO&M bucket will only be used by the FAMIS system and 
will not be reallocated through Manual entries. 
 
Internal Revenue Internal Expense 

  1731-CIP CONST FO&M Charges 

  1732-CIP CONST FO&M Labor 

  1733-CIP CONST FO&M Materials 

  1765-CIP A E Internal Project Mgmt 

  1767-CIP A E FO&M Engineering 

  1782-CIP ADMIN Internal Fees 

  1786-CIP ADMIN Internal Utilities 

  1804-CIP OTHR Other Internal Charges 

  5474-NONOP NONCAP Intnl Equip under 5000 

  5483-NONOP NONCAP Internal Charges 

  5484-NONOP NONCAP Intnl Equip 5000-24999 

  5486-NONOP NONCAP Internal Admin Fees 

 Revenue Expense 

4811-SERVICE CTR Animal Operating Room 7811-SERVICE CTR Animal Operating Room 

4812-SERVICE CTR Audio Visual Servcs 7812-SERVICE CTR Audio Visual Servcs 

4813-SERVICE CTR Backup Network Srvcs 7813-SERVICE CTR Backup Network Srvcs 

4814-SERVICE CTR Computing Assist Srvcs 7814-SERVICE CTR Computing Assist Srvcs 

4815-SERVICE CTR Copying 7815-SERVICE CTR Copying 

4816-SERVICE CTR Design and Construction 7816-SERVICE CTR Design and Construction 

4817-SERVICE CTR Glassware Washing 7817-SERVICE CTR Glassware Washing 

4818-SERVICE CTR Hazardous Waste Dispose 7818-SERVICE CTR Hazardous Waste Dispose 

4819-SERVICE CTR Laboratory Analysis 7819-SERVICE CTR Laboratory Analysis 

4821-SERVICE CTR Mailing Services 7821-SERVICE CTR Mailing Services 
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4822-SERVICE CTR Printing 7822-SERVICE CTR Printing 

4823-SERVICE CTR Repair Shops 7823-SERVICE CTR Repair Shops 

4824-SERVICE CTR Research Animals Fee 7824-SERVICE CTR Research Animals Fee 

4825-SERVICE CTR Use of Equipment 7825-SERVICE CTR Use of Equipment 

 Revenue Expense 

4851-INT DEPT Catering 7851-INT DEPT Catering 

4852-INT DEPT Alcoholic Beverages 7852-INT DEPT Alcoholic Beverages 

4853-INT DEPT Copying and Printing 7853-INT DEPT Copying and Printing 

4854-INT DEPT Educational Programs 7854-INT DEPT Educational Programs 

4855-INT DEPT Fees 7855-INT DEPT Fees 

4856-INT DEPT Rooms 7856-INT DEPT Rooms 

4857-INT DEPT Meals and Beverages 7857-INT DEPT Meals and Beverages 

4858-INT DEPT Security Services 7858-INT DEPT Security Services 

4861-INT DEPT Museum Poster Program 7861-INT DEPT Museum Poster Program 

4862-INT DEPT Rentals 7862-INT DEPT Rentals 

4863-INT DEPT Sales 7863-INT DEPT Sales 

4865-INT DEPT Calling Card Charges 7865-INT DEPT Calling Card Charges 

4866-INT DEPT Communication Monthly Fee 7866-INT DEPT Communication Monthly Fee 

4867-INT DEPT Internatl Long Distance 7867-INT DEPT Internatl Long Distance 

4868-INT DEPT Toll Free Charges 7868-INT DEPT Toll Free Charges 

4869-INT DEPT Services 7869-INT DEPT Services 

4871-INT DEPT Institutnl Review Board Fee 7871-INT DEPT Institutnl Review Board Fee 

4872-INT DEPT Clncl Cncr Rsrch Cmmtt Fee 7872-INT DEPT Clncl Cncr Rsrch Cmmtt Fee 

4873-INT DEPT Clinical Rsrch Admin Fees 7873-INT DEPT Clinical Rsrch Admin Fees 

4874-INT DEPT Books and Publications 7874-INT DEPT Books and Publications 

4875-INT DEPT Computer Equip less 4999 7875-INT DEPT Computer Equip less 4999 

4876-INT DEPT Computer Equip more 5000 7876-INT DEPT Computer Equip more 5000 

4877-INT DEPT Computer Software 7877-INT DEPT Computer Software 

4878-INT DEPT Postage Freight Shipping 7878-INT DEPT Postage Freight Shipping 

4879-INT DEPT Maintenance Contracts 7879-INT DEPT Maintenance Contracts 

4881-INT DEPT Telephone Equipment 7881-INT DEPT Telephone Equipment 

4882-INT DEPT Promotional Costs 7882-INT DEPT Promotional Costs 

4883-INT DEPT Repayment 7883-INT DEPT Repayment 

 Revenue Expense 

4701-INTERNAL FOM REV Chiller 8001-INTERNAL FOM DIST Chiller 

4702-INTERNAL FOM REV Electricity 8002-INTERNAL FOM DIST Electricity 

4703-INTERNAL FOM REV Energy Mgmt Systm 8003-INTERNAL FOM DIST Energy Mgmt Systm 

4704-INTERNAL FOM REV Water 8004-INTERNAL FOM DIST Water 

4705-INTERNAL FOM REV Steam 8005-INTERNAL FOM DIST Steam 

4706-INTERNAL FOM REV Sewer 8006-INTERNAL FOM DIST Sewer 

4707-INTERNAL FOM REV Custodial Contract 8007-INTERNAL FOM DIST Custodial Contrct 

4708-INTERNAL FOM REV Custodial Labor 8008-INTERNAL FOM DIST Custodial Labor 

4709-INTERNAL FOM REV Custodial Materl 8009-INTERNAL FOM DIST Custodial Materl 

4711-INTERNAL FOM REV Engineering Contrt 8011-INTERNAL FOM DIST Engineering Cntrt 

4712-INTERNAL FOM REV Engineering Labor 8012-INTERNAL FOM DIST Engineering Labor 

4713-INTERNAL FOM REV Engineering Matrl 8013-INTERNAL FOM DIST Engineering Matrl 

4714-INTERNAL FOM REV Trade Contracts 8014-INTERNAL FOM DIST Trade Contracts 

4715-INTERNAL FOM REV Trades Labor 8015-INTERNAL FOM DIST Trades Labor 

4716-INTERNAL FOM REV Trade Materials 8016-INTERNAL FOM DIST Trade Materials 

4717-INTERNAL FOM REV Composting 8017-INTERNAL FOM DIST Composting 

4718-INTERNAL FOM REV Recycling 8018-INTERNAL FOM DIST Recycling 

4719-INTERNAL FOM REV Trash Removal 8019-INTERNAL FOM DIST Trash Removal 

4721-INTERNAL FOM REV Equip Rental 8021-INTERNAL FOM DIST Equip Rental 

4722-INTERNAL FOM REV Trucking 8022-INTERNAL FOM DIST Trucking 

4723-INTERNAL FOM REV Grounds Maint 8023-INTERNAL FOM DIST Grounds Maint 

  



Dartmouth College  Manual Journal Entries with Web ADI 
 

38 
Effective 11/10/09 

Reference Information  
 

Budget-Only Natural Classes 
 

Operating revenue and non-compensation expense 
 
Certain natural class values are available for high-level forecasting during the budgeting process.  
For example, there are natural class values for both restricted and unrestricted gift bequests that 
are used only for high-level budgeting. These values are NOT used when recording actual 
transactions.  A security rule will prevent use of these NCs for manual transactions. 

 
4000-TUITION AND FEES Budget Only 

4162-SPONSORED Indirect Rev Budget Only 

4220-GIFTS BEQ UNRESTR Budget Only 

4240-GIFTS BEQ RESTR Budget Only 

4300-ENDOW DIST Budget Only 

4400-INV INC Investment Inc Budget Only 

4430-SALES AND OTHER REV External Budget 

4440-OTHR INC STUDENT RB Room Board Bdgt 

4530-PATIENT LAB Services Budget Only 

4570-HOSPITAL PUR SRV REV Budget Only 

4580-OTHER PUR SRV REV Budget Only 

4640-OTHR INC Budget Only 

4700-INTERNAL FOM REV Budget Only 

4800-INTERNAL DEPART REV Budget Only 

7000-SCHOLARSHIP AWRDS Budget Only 

7020-EQUIP FURN FIX UNDER 5000 Budget 

7100-EQUIP FURN FIX 5000 to 24999 Budget 

7200-OPERATING LEASE RENTALS Budget Only 

7240-MAINT AND REPAIRS Budget Only 

7300-MAINT CONTRACTS Budget Only 

7340-COGS Budget Only 

7400-MATERIAL AND SUPPLIES Budget Only 

7530-BOOKS MEDIA Budget Only 

7550-CAP Items over 25000 Budget Only 

7600-PURCHASED SERVICES External Budget 

7650-INSURANCE Budget Only 

7680-POSTAGE FRGHT SHIP Budget Only 

7700-PROF FEES Budget Only 

7800-INTERNAL DEPART CHARGES Budget Only 

7930-PROF SRVCS CLINIC Budget Only 

8000-INTERNAL FOM DIST Budget Only 

8040-UTIL COMMUNICATION Budget Only 

8070-WASTE REMOVAL Budget Only 

8110-TRAVEL FOREIGN Budget Only 

8200-ENTERTAINMENT Budget Only 

8400-OTHER OPERATING EXPENSE Budget Only 

8480-TAXES Budget Only 

8620-DEBT SERV INT PRIN Budget Only 

8700-DEP Depreciation Budget Only 

 


